AB 123 Course Name		Semester [year] Syllabus
	[bookmark: _GoBack]Course Syllabus Template and Instructions

	Revised: January 29, 2020

	· Re: https://www.google.com/url?q=https://aan.msu.edu/wp-content/uploads/2017/08/final-accessible-syllabus-checklist.pdf&sa=U&ved=0ahUKEwj2j4Tc5svbAhXl5YMKHdzWA7EQFggFMAA&client=internal-uds-cse&cx=017457587781802196523:w_mhaibhhcu&usg=AOvVaw1FxLOMNJmL5S5XMR7Vvw2K [Link to be replaced. Need a nice clean link that will stay the same across all future versions so that links to it will "never" be broken. Notice how the above revised date is within the document at the top as will be version information below the course name for a class.]
· Follow the guidelines found in the MSU accessibility tutorials and in particular the Microsoft Word tutorial.
· The syllabus is broken into discrete parts, which can be rearranged, removed, or modified to best fit your course and teaching style. Be aware that rearrangement may require reworking heading levels.
· Adjust descriptions of activities and outcomes to fit your course.
· Look for green, italicized (styled with the Emphasis style) and/or [bracketed] text used as placeholders, to indicate information needed, text you should change, or notes. Be sure to delete notes before finalizing your syllabus and select and change any green, italicized blocks to Normal style or a correct Heading style/level.
· Items required by the Code of Teaching Responsibility are prefixed by ***Required*** however, for example, if there are no Teaching Assistants then no Teaching Assistants’ information is required and the entire relevant block can be deleted.
· Be sure to remove references to tools, activities, or outcomes that you do not plan to use in your course.
· The syllabus includes some common language to describe campus policies and services to serve as a guideline for you. Be sure to read these sections and change language to fit your course needs. But see the checklist and policies themselves to be sure you are not modifying required language.
· Don’t forget to rename this document to something more appropriate for your course, e.g., syllabus_spring_2020_ab_123

	The steps below should be done in the offline standalone Microsoft Word.
1. Check for accessibility (fix then retest). Review > Check Accessibility
2. Select the text of the course name, copy it with ctrl-c, File > Add a title, ctrl-v to paste in the copied course name.
3. Search and Replace “***Required***” with nothing being sure that required information is in place.
4. You will need to do the two steps after this step after this table is deleted so you may want to make a note of those steps. To delete this table, click anywhere in this table, in the ribbon menu click on the table Layout tab then click the "Delete" and/or "Delete Table" option to remove this table.
5. Update table of contents. References > Update Table > Update entire table
6. Post the Word document in D2L (or wherever) as part of your class material. Providing it in electronic Word file form rather than a printout is strongly recommended.
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[bookmark: _Toc28941351]Part 1: Course Information
Credit Hours: 3
Meeting Days/Times: weekday start-end or MWF start-end
Meeting Location: building and room
Website: whatever.msu.edu
[bookmark: _Toc28941352]Instructor Information
Instructor: Name
Preferred pronouns: she, her, hers, etc.
***Required***Office: Location
***Required***Office Hours: Times & Days (Note: if online, explain how to access)
***Required***Appointments Outside Office Hours: how to make an appointment
***Required***Office Telephone: Phone Number
***Required***E-mail: E-mail address (Note: specify your preferred contact)
Website: whatever.msu.edu, Zoom room link, other electronic meeting/chat place
[bookmark: _Toc28941353]Graduate Teaching Assistant
Assistant: Name
Preferred pronouns: she, her, hers, etc.
***Required***Office: Location
***Required***Office Hours: Times & Days (Note: if online explain how to access)
***Required***Appointments Outside Office Hours:
***Required***Office Telephone: Phone Number
***Required***E-mail: E-mail address (Note: specify your preferred contact)
Website: whatever.msu.edu
[bookmark: _Toc28941354]***Required***Course Description
Enter course description here. Instructors shall be responsible for ensuring that the content of the courses they teach is consistent with the course descriptions approved by the University Committee on Curriculum and the University Council. Instructors shall direct class activities toward the fulfillment of course objectives and shall evaluate student performance in a manner consistent with these objectives.
[bookmark: _Toc28941355]Course Overview:
This is an opportunity to expand on the course description and give students a glimpse into what the course will be like. You may discuss course format (lecture, seminar, lab, studio, etc.), relevance to students’ academic and professional goals, and major deliverables (final paper, project, exam, etc.).
[bookmark: _Toc28941356]Prerequisites[/Co-requisites]
Enter prerequisite information here, if applicable.
[bookmark: _Toc28941357]***Required***Textbook & Course Materials
List required course textbooks here. Include detail such as full name of textbook, author, edition, ISBN, description (if desired), and where it can be purchased. If a required text is available online, indicate where it can be accessed. In selecting/preparing materials abide by the MSU Accessibility Policies.
[bookmark: _Toc28941358]***Required***Recommended Texts & Other Readings
How and where to expect to access other readings throughout the course.
[bookmark: _Toc28941359]Course Requirements
· Internet connection (DSL, LAN, or cable connection desirable)
· Access to Desire2Learn (D2L), or other delivery platform.
· Any other tools, resources, and materials needed by the student for the course.
[bookmark: _Toc28941360]Course Structure
This course will be delivered online through the course management system and you will need your MSU NetID to login to the course from the [https://d2l.msu.edu/ (d2l.msu.edu)].
In D2L, you will access online lessons, course materials, and additional resources. Activities may consist of readings, discussion forums, email, journaling, wikis, and other online activities. Add and remove listed activities as appropriate to your course.
[bookmark: _Toc28941361]Technical Assistance
If you need technical assistance at any time during the course or to report a problem you can:
· Visit the Distance Learning Services Support Site (lib.msu.edu/dls)
· Visit the Desire2Learn Help Site (help.d2l.msu.edu)
· Or call Distance Learning Services: (800) 500-1554 or (517) 355-2345
· To learn D2L use, login with your MSU NetID and password at d2l.msu.edu, select “Self Registration” from the menu bar, register for and complete the course named “Students - Getting Started with D2L.” Also be aware of the “Help” option on the D2L Home page menu.
[Note: Information helpful for the use of required software, including D2L: Include information on how to navigate necessary software, expectations, instructions on how to access course material, and where to find technical assistance. Delete the above D2L bullet if it is not appropriate. (please delete)]
[bookmark: _Toc28941362]Resource Center for Persons with Disabilities (RCPD) 
· To make an appointment with a specialist, contact: (517) 353-9642 
Or TTY: (517) 355-1293
· Web site for RCPD: MYProfile.rcpd.msu.edu


[bookmark: _Toc28941363]***Required***Part 2: Instructional Objectives 
[Note: These must align with the course description. You can contact the Academic Advancement Network for additional information in developing measurable learning objectives. (please delete)]
The primary learning objectives for this course are:
List the primary learning objectives for this course here.
· Objective
· Objective
· Objective
You will meet the objectives listed above through a combination of the following activities in this course:
Provide instructions to students on how they are expected to meet the learning objectives for the course here. For example: Will most objectives be met through examination? Or through participation? Or through projects?
· Attend …
· Complete … 
· Participate …


[bookmark: _Toc28941364]***Required***Part 3: Course Outline/Schedule 
[Note: This must include the date of the final examination and tentative dates of required assignments, quizzes, and tests if applicable. While it is important to clearly indicate the schedule for your course, there are many places where you may do this. You may include a topic outline/schedule (like the examples shown below) in your syllabus, make a separate link to a schedule document in your course, or use the D2L calendar tool. Regardless of which you choose, be consistent, keep your calendar up-to-date, and let students know when it changes to help students follow along, reduce confusion, and emphasize time on task.
Assignment descriptions: Assignments should be aligned with course goals and the course description. The syllabus should include information on how assignments will be graded including grading rubrics when applicable. Be clear about assignment and submission deadlines. (please delete)]
Important Note: Refer to the course calendar for specific meeting dates and times. Activity and assignment details will be explained in detail within each week's corresponding learning module. If you have any questions, please contact your instructor.
Week 01: Topic here
· Details here …
Week 02: Topic here
· Details here …
Week 03: Topic here
· Details here …
Week 04: Topic here
· Details here …
Week 05: Topic here
· Details here …
[Note: when editing tables such as the below do not split or merge cells because that will break the accessibility of the table. Adding or removing column should be done carefully and the accessibility checked and reset as needed following the instructions in the Webaccess.msu.edu Word Tutorial (webaccess.msu.edu/Tutorials/word.html). (please delete)] 
	Week
	Date
	Topic
	Readings
	Activities
	Due Date

	Week 1
	January …
	
	
	
	

	Week 2
	
	
	
	
	

	Week 3
	
	
	
	
	

	Week 4
	
	
	
	
	




[bookmark: _Toc28941365]***Required***Part 4: Grading Policy
[Note: The syllabus must make clear how students will be evaluated, and specifically how final grades will be determined. This can be in the form of a rubric or chart. Grade percentages must be provided so that students may understand how their final grade will be calculated. If a grading curve is used, this must be shared, and instructors must let students know how the curve will be calculated. The example subsections shown below are only illustrative but could provide good guides. (please delete)]
[bookmark: _Toc28941366]Graded Course Activities
The table below describes the graded course activities including points and activity description. The first column includes the points possible, and the second column includes a description for each activity.
	Points
	Description

	#
	Item 1 (List all activities, tests, etc. that will determine the students’ final grade) 

	#
	Item 2

	100
	Total Points Possible


[bookmark: _Toc28941367]Late Work Policy
Explain your policy here clearly to the student.
[bookmark: _Toc28941368]Viewing Grades
Include a statement about the timeframe of when students can expect grades here, and how they will be able to access them. Perhaps via grades in D2L for example.


[bookmark: _Toc28941369]Letter Grade Assignment (Grading Scale)
[Note: Change the above heading as appropriate. This table is subject to change based on how your unit’s grading scale is structured, e.g. using a letter grade or a numerical grade. For example, delete the “Letter Grade” column if appropriate. Also be sure that the percentages assigned are what you use in your unit. (please delete)]
The table below describes the relationships between letter grades, percent, and performance. The first column describes the letter grade. The second column describes the percentage associated with that letter grade. The third column describes the performance represented by that letter grade and percentage.
	Letter Grade
	Percentage
	Performance

	A (4.0)
	93 to 100%
	Excellent Work

	A-
	90 to 92%
	Nearly Excellent Work

	B+
	87 to 89%
	Very Good Work

	B
	83 to 86%
	Good Work

	B-
	80 to 82%
	Mostly Good Work

	C+
	77 to 79%
	Above Average Work

	C
	73 to 76%
	Average Work

	C-
	70 to 72%
	Mostly Average Work

	D+
	67 to 69%
	Below Average Work

	D
	60 to 66%
	Poor Work

	F
	0 to 59%
	Failing Work


[bookmark: _Toc28941370]Required Proctoring for Grading
Any required proctoring arrangements to which students must adhere: this includes location or login restrictions, lockdown browsers, or software requirements necessary for proctored exams or assignments.


[bookmark: _Toc28941371]Part 5: Course Policies
Students are expected to adhere to the policies of Michigan State University whether noted in this syllabus or not. Instructors have the right to add or adjust policies within limits for the specifics of their courses. While the below may appear at first glance to be common policy boilerplate there may be nuances or course specifics within it that the student must be aware of and adhere to.
[bookmark: _Toc28941372]Applicable policies, syllabus statements, and resources for students: 
· Spartan Code of Honor
· Mental Health
· Religious Observance Policy
· Student Athletes
· Pronoun preference
[Note: Instructors are encouraged to follow any links above and decide what text, if any, to incorporate into this syllabus. (please delete)]
[bookmark: _Toc28941373]Commit to Integrity: Academic Honesty
Article 2.III.B.2 of the Academic Rights and Responsibilities states that "The student shares with the faculty the responsibility for maintaining the integrity of scholarship, grades, and professional standards." In addition, the [insert name of unit offering course] adheres to the policies on academic honesty as specified in General Student Regulations 1.0, Protection of Scholarship and Grades; the all-University Policy on Integrity of Scholarship and Grades; and Ordinance 17.00, Examinations. See Spartan Life Online (splife.studentlife.msu.edu) and/or the MSU Web site (msu.edu) for more.
Therefore, unless authorized by your instructor, you are expected to complete all course assignments, including homework, lab work, quizzes, tests and exams, without assistance from any source. You are expected to develop original work for this course; therefore, you may not submit course work you completed for another course to satisfy the requirements for this course. Also, you are not authorized to use the www.allmsu.com Web site to complete any course work in this course. Students who violate MSU academic integrity rules may receive a penalty grade, including a failing grade on the assignment or in the course. Contact your instructor if you are unsure about the appropriateness of your course work. (See also the Academic Integrity webpage.)
[bookmark: _Toc28941374]Limits to Confidentiality
Essays, journals, and other materials submitted for this class are generally considered confidential pursuant to the University's student record policies. However, students should be aware that University employees, including instructors, may not be able to maintain confidentiality when it conflicts with their responsibility to report certain issues to protect the health and safety of MSU community members and others. As the instructor, I must report the following information to other University offices (including the Department of Police and Public Safety) if you share it with me:
· Suspected child abuse/neglect, even if this maltreatment happened when you were a child,
· Allegations of sexual assault or sexual harassment when they involve MSU students, faculty, or staff, and
· Credible threats of harm to oneself or to others.
These reports may trigger contact from a campus official who will want to talk with you about the incident that you have shared. In almost all cases, it will be your decision whether you wish to speak with that individual. If you would like to talk about these events in a more confidential setting you are encouraged to make an appointment with the MSU Counseling Center.
[bookmark: _Toc28941375]Inform Your Instructor of Any Accommodations Needed
From the Resource Center for Persons with Disabilities (RCPD): Michigan State University is committed to providing equal opportunity for participation in all programs, services and activities. Requests for accommodations by persons with disabilities may be made by contacting the Resource Center for Persons with Disabilities at 517-884-RCPD or on the web at rcpd.msu.edu. Once your eligibility for an accommodation has been determined, you will be issued a Verified Individual Services Accommodation ("VISA") form. Please present this form to me at the start of the term and/or two weeks prior to the accommodation date (test, project, etc.). Requests received after this date will be honored whenever possible.
[bookmark: _Toc28941376]Drops and Adds
The last day to add this course is the end of the first week of classes. The last day to drop this course with a 100 percent refund and no grade reported is [insert date]. The last day to drop this course with no refund and no grade reported is [insert date]. You should immediately make a copy of your amended schedule to verify you have added or dropped this course.
[bookmark: _Toc28941377]Commercialized Lecture Notes
Commercialization of lecture notes and university-provided course materials is [permitted] [not permitted] in this course.*
*Note: The Code of Teaching Responsibility requires instructors who permit students to commercialize their class lecture notes to include a statement in their course syllabi that gives such permission. Absent such permission, students may not do so.
[bookmark: _Toc28941378]Internet
Some professional journals will not consider a submission for publication if the article has appeared on the Internet. Please notify your instructor in writing if you do not want your course papers posted to the course Web site.
[bookmark: _Toc28941379]Disruptive Behavior
Article 2.III.B.4 of Student Rights and Responsibilities for students at Michigan State University states: "The student's behavior in the classroom shall be conducive to the teaching and learning process for all concerned." Article 2.III.B.10 states that "The student and the faculty share the responsibility for maintaining professional relationships based on mutual trust and civility." General Student Regulation 5.02 states: "No student shall . . . obstruct, disrupt, or interfere with the functions, services, or directives of the University, its offices, or its employees (e.g., classes, social, cultural, and athletic events, computing services, registration, housing and food services, governance meetings, and hearings).” Students whose conduct adversely affects the learning environment may be subject to disciplinary action through the Student Judicial Affairs office.
[bookmark: _Toc28941380]***Required***Attendance
[Note: if different from the university attendance policy and especially when that attendance policy affects student grades. You can find information regarding MSU’s attendance policies on the website for the Office of the University Ombudsperson. The following is suggested when the class attendance policy is the university policy. (please delete)]
University Attendance Policy (in part): Students whose names do not appear on the official class list for this course may not attend this class. Students who fail to attend the first four class sessions or class by the fifth day of the semester, whichever occurs first, may be dropped from the course.
[bookmark: _Toc28941381]Participation
Students are expected to participate in all online activities as listed on the course calendar. Enter specific points regarding attendance policy here.
If you monitor, track, and/or score student participation, explain how you will keep track and how often students should be accessing the course. If appropriate, mention that you will be using D2L tracking tool, discussions, chat sessions, and group work, to monitor their participation in the course.
[bookmark: _Toc28941382]Build Rapport
If you find that you have any trouble keeping up with assignments or other aspects of the course, make sure you let your instructor know as early as possible. As you will find, building rapport and effective relationships are key to becoming an effective professional. Make sure that you are proactive in informing your instructor when difficulties arise during the semester so that we can help you find a solution.
[bookmark: _Toc28941383]Complete Assignments
Assignments for this course will be submitted electronically through [D2L] unless otherwise instructed. Assignments must be submitted by the given deadline or special permission must be requested from instructor before the due date. Extensions will not be given beyond the next assignment except under extreme circumstances.
All discussion assignments must be completed by the assignment due date and time. Late or missing discussion assignments will affect the student’s grade.
[bookmark: _Toc28941384]Other Classroom Expectations
Can include policies around tardiness, late submissions, cell phones and electronic devices, communication policies and expectations, language around syllabus changes. You may insert other “Heading 3” styled headings as you see fit, e.g., one for “Technology Use in Class.”
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